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Overview
 Kurzweil 3000 software program offers integrated features that promote and aid students in Reading, Studying, and Writing. Based on Universal Design for Learning principles, it provides users with multiple ways to access information and curriculum, and with tools to help them accomplish tasks independently, practice active learning skills, and demonstrate acquired knowledge.
To Use
Opening and Closing Kurzweil 3000
To start Kurzweil 3000 click the Kurzweil 3000 icon on the desktop’s dock or in the Application folder. [image: http://www.macupdate.com/images/icons256/24885.png]
Note: You will always need to log on with your username and password. 
After logging in, Kurzweil 3000 will provide you options to create a New .kes (Kurzweil) file, Open an existing .kes file, Read the Web, or Scan a document if a scanner is connected. Kurzweil 3000 can import PDF files directly into a .kes file. Other files, such .doc or .ppt files, can be converted into a PDF file and imported into Kurzweil by selecting Print in that program, clicking PDF in the print window, and choosing the Open as PDF in Kurzweil 3000 option.
[image: ATRC HD:Users:atrc:Desktop:Screen Shot 2015-10-21 at 1.49.25 PM.png]
To quit Kurzweil 3000, there are three options: 
1. From Kurzweil 3000 drop-down menu, select Quit Kurzweil 3000.
2. Double click (or control + click) the Kurzweil 3000 icon in the dock, and select Quit.
3. Press ⌘ + Q at the same time.
Organization
Kurzweil 3000 Window
When Kurweil 3000 is open, the window will show tools for reading, writing, annotation and other tasks at the top of the file.
Navigating the Pages
On the bottom-right of the Kurzweil 3000 window, arrows and a text box are available for changing the page forward or backward 1 page, or locating the page number entered. At the bottom-left of the Kurzweil 3000 window, a toggle bar with a plus and minus sign (+, -) is available for adjust the magnification of the document. 
Customizing the Window
 This toolbar can be customized three ways:
1. Clicking on the View drop-down menu at the top of the screen, hover the pointer over Current Toolbar, and select a preexisting toolbar (i.e. Scanning, Studying, Writing, etc.)
2. Clicking on the View drop-down menu at the top of the screen, then selecting Customize Toolbar… 
3. Right-clicking (ctrl + click) on any open space within the toolbar, and selecting Customize Toolbar…
By choosing Customize Toolbar…, a menu will open with a variety of tools that can be selected to be in the toolbar for easy access. Click and drag the icon from the menu into your toolbar to add it to the window’s toolbar. When finished your customization, select Done.
Kurzweil 3000 Reader
The window provides easy access to control the programs text-to-speech function, which reads aloud the text within a .kes file or on the web. 
· After selecting text or placing the cursor within the text, the Read/Play function initiates the audio output, which can be stopped by selecting the same icon. 
· The Next Sentence or Previous Sentence arrows will navigate the text-to-speech through the text. 
· The Unit scrollbar allows the user to adjust whether the text will be read by word, sentence, or paragraph . 
· The Mode scrollbar adjusts the pace of the text to be continuously read through the whole text or manually by the reader. 
· The Voice scrollbar provides options of the style of voice for the text to be read. 
· An option for the text to be read Aloud or Silently, allows the user to see the highlight tracking of the words without audio output. 
· The Words per Minute box changes the speed by which the text is read aloud.
· If the Reader toolbar does not appear, click Window in the main toolbar and select Show Reader. 
[image: Screen%20Shot%202015-11-24%20at%203.23.22%20PM.png]
Annotation Toolbar
A selection of tools are available to manipulate and annotation within the text, including a selector, eraser, 6 highlighter colors, 2 colors for circling, footnotes, voice notes, sticky notes, text notes, bubble notes, and bookmarks. To use these functions, click on their icon and then click within the text in the location they will be used. If the Annotation toolbar does not appear click Window in the main toolbar at the top of the screen and then select Show Tools. 

[image: Screen%20Shot%202015-11-24%20at%203.25.33%20PM.png]
Reading Tools
Read/Pause, Next Sentence, & Previous Sentence
Read/Pause is used to initiate the computer’s text-to-speech function, reading selected text aloud. The Next Sentence and Previous Sentence functions are used to navigate between sentences within a text. 
[image: Screen%20Shot%202015-11-24%20at%203.47.10%20PM.png]
Look Up Word
Like a dictionary, this function can provide definition by selecting a word on the page and clicking the Look Up Word button, or entering a word into the designated spot in the window.
 [image: Screen%20Shot%202015-11-24%20at%203.47.46%20PM.png]
Create Audio File
This feature allows the user to create an audio (i.e. .mp3) file of the text read aloud by the computer’s text-to-speech function. After clicking this function, a window will open, providing options for the user to adjust the voice and speed of the reading, add or remove annotations, select an audio format, and choose a location for the audio file to be downloaded to.
 [image: Screen%20Shot%202015-11-24%20at%203.46.36%20PM.png]
Extract Notes & Highlighted Text
This feature is used to collect all or a select group of annotations, such as highlights, sticky notes, or footnotes, and place them into a separate document. A window will appear after selecting this tool, which allows the user to choose which annotation to be collected. Click Extract, and a new window will appear with that collection. 
[image: Screen%20Shot%202015-11-24%20at%203.47.34%20PM.png]
Edit Zones
This tool allows users to reorder areas of text within the page or delete text that the user does not want read aloud (i.e. captions or page numbers). After selecting this tool, Kurzweil 3000 will show the areas of text that have been identified and the current order they will be read aloud in. [image: Screen%20Shot%202015-11-29%20at%203.32.23%20PM.png]
To change the reading order, the user can manually drag the text boxes in the order they should be read. Or the user can press control and click at the same time, which will open a list of options for editing the text box highlighted, such as changing it from a Primary text to a Secondary text, or sending it forward or backward in reading order. To add a text box, click and drag the mouse anywhere on the page to create a new text zone. 
Writing Tools
Spell Check
By clicking the Spell Check feature, Kurzweil 3000 will identify words within your text that are not located in it’s own dictionary. Kurzweil 3000 will make suggestions for words that you may have been trying to write, providing options for defining these words, or ignoring the recommendations altogether.
 [image: Screen%20Shot%202015-11-24%20at%203.48.19%20PM.png]
Toggle Word Prediction
Clicking on the Toggle Word Prediction button will open a new window, which will show a list of words that Kurzweill 3000 predicts you are currently typing.
 [image: Screen%20Shot%202015-11-24%20at%203.48.02%20PM.png]
Brainstorm (Bubble or Concept Mapping)
Brainstorm allows users to create a visual outline of ideas using text, bubbles, arrows, and shapes to organize ideas into a structured map.
Opening a Brainstorm File
To open Brainstorm, click File, place sursor over Start Writing, then over Brainstorm, and then choose either Blank (a new document )or From Template… (a preexisting model of a brainstorming map). [image: Screen%20Shot%202015-11-29%20at%203.06.05%20PM.png]
Using Brainstorm
The default Brainstorm window opens with the work area containing a single "thought" in an Oval shape, as a starting point for your diagram. A floating tools palette, containing tools to create new shapes and link them together, appears as well. To link two shapes together with an arrow, click a shape, then click the Link tool, and finally click the second shape. If the toolbar does not appear when you open the brainstorm feature click Window in the main toolbar at the top of the screen and then select Show Tools. 
[image: C:\Users\ahflint\AppData\Local\Temp\Screen Shot 2015-12-11 at 1.32.02 PM.png]
Creating a Draft from Brainstorm
From the Brainstorm diagram, click Outline view. In Outline view, click the Create Draft button  [image: Screen%20Shot%202015-11-29%20at%203.27.47%20PM.png] in the tools palette. The outline text appears in the draft, ready for you to expand into prose.
Using Outlines
The outline is an alternative way to begin the writing process. Kurzweil 3000 Outline lets you jot down your ideas and organize your thoughts into a writing plan. Organize your ideas using the basic outline pallet toolbox. 
· Select the Outline Icon[image: Screen%20Shot%202015-11-29%20at%203.23.01%20PM.png] in the writing toolbar to begin a new outline or to switch to this view.
· Use the floating tools palette to create a meaningful and organized outline. 
· Switch between the various views to continue the writing process
· Other writing features not highlighted in this quick start guide include review writing feature, spell check, word prediction. All features of the main tool bar are available for use during the writing process. 
Saving a Document 
The default setting for saving a document is as a .kes file. Saving a file as a .kes ensures that all annotations (highlights, notes, brainstorms etc.) are preserved. Documents can be saved as several file types; however this does not ensure annotation preservations. To save: 
1. Click File, then Save OR click the Save icon on the toolbar.
2. Select location on your computer to save document as a (.kes) file. 
3. You will be prompted to save documents including column notes, outlines, etc. upon closing them with the x in the upper right hand corner of the dialogue box. 
Basic Scanning
To scan your own documents into a KEZI file: 
1. Make sure your scanner or document camera* is turned on.
2. Place the material to be scanned on the scanner glass (or under the document camera).
3. Click the Scan button in the Main toolbar. [image: ]
4. When the scan is complete the page image appears in the Kurzweil 3000 document area. Each new page you scan is added to the end of the document.
5. A document undergoes optical character recognition (OCR) whenever scanned or printed to Kurzweil.  
Reading Websites
The Read the Web feature lets you read Web sites using Kurzweil 3000 and the latest version of Mozilla Firefox. While reading the Web, you have access to Kurzweil 3000 reading and reference tools. If you want to use Mozilla Firefox, see online Help or the Installation Guide.
To Read Website Content: 
1. Click the Read the Web button [image: Screen%20Shot%202015-11-24%20at%204.08.03%20PM.png] in the Explore toolbar, or select Read the Web from the Read menu.
2. The Web browser opens and connects to your home page. In Firefox, the Read the Web toolbar appears below the browser toolbars.
3. Click the Read button to begin reading.
4. Look up a word by selecting it, then clicking the Definition button in the toolbar.
Firefly Online Account
Access limited features of Kurzweill 3000 remotely from any computer with an internet connection using this web-based version. 
Access Your Account
To access the mobile feature of Kurzweil 3000 utilize the Firefly website:
1. Go to firefly login (www.fireflybykurzweil.com) 
2. Login to site with username and password. 
Note: limited features are available with this web version of Kurzweil 3000.  
Upload and Save Documents 
1. To upload documents, utilize the universal library under the home tab.  
2. Select to either open a file from Google Drive, Bookshare, your computer or upload a file. 
[image: ../../../../../../../Desktop/Screen%20Shot%202015-11-29%20at%202.50]
3. If your file type is not able to upload, you may consider opening the file and using KEZI import printer from previous directions. 
To open a document 
1. To open a document, use the Universal Library under the Home tab.  
2. Navigate to saved document (private, Public, or recently opened local files)
3. Double click document icon. 
[image: Screen%20Shot%202015-11-29%20at%202.52.37%20PM.png]
4. While working within an open document, utilize the Back to Library button in the main toolbar to open additional documents. 
Navigating a Document
To navigate to the previous page or Next page, click the large Left Arrow or Right Arrow button on either side of the page display. To go to a specific page, enter the page number in the Go to page box at the bottom of the firefly window, and then click the Arrow button or press Enter.
Adjust Setting Options
1. To adjust general settings, hover cursor over the Options tab.  
2. Make selections for settings based on reading speed, reading unit, reading mode, voice, and toolbar location. 
[image: ]
Reading Features
1. To Read, using dual highlighting, click the green Play button.
2. To move the cursor Backward to the previous reading unit or Forward to the next reading unit, click the DoubleLeft Arrow or DoubleRight Arrow button in the Reading button set. 
3. Click the Play button to read from that point. See figure below. 
[image: ]
4. Note that the green Play button transforms to a green Pause button when pressed. 
Highlighting Features
To highlight text in a document: 
1. Hover over the Tool Selection button and select a color pen from the Highlight Text area. 
[image: ]
2. In the document, select the text you want to highlight. 
3. Repeat step 1 whenever you want to highlight in a different color. 
4. When you are done, click the Select Text button to end the highlighting function. 
To erase highlighting: 
1. Hover over the Tool Selection button and click the Erase Highlights button. 
2. In the document, drag-select the highlighted text you want to erase. 
3. When you are done, click the Select Text button to end the erase function. 
To save highlights: 
1. After highlighting, navigate to another page or click the Back to Library button which will save your highlights.
2. Do not close the browser or leave the firefly website, otherwise, you may lose the highlights for the session.
 Notes about saving highlights: 
In firefly, you can view highlights that were added to a .KES document in Kurzweil 3000. Be sure to save the document to the Library from Kurzweil 3000 after you add or change the highlights. Highlighting added in firefly will not display when you open that document in Kurzweil 3000. 
Firefly K3000 Mobile App [image: Screen%20Shot%202015-11-29%20at%203.42.31%20PM.png]
Use limited reader features of Kurzweil 3000 on your IOS mobile device. Download the free Firefly app from the iTunes store at the following link: 
Apple iTunes Firefly App (https://itunes.apple.com/us/app/firefly-k3000/id535277727?mt=8)
 Find a detailed user guide from Kurzweil at the following link: 
Kurzweil Firefly App User Guide (http://www.kurzweiledu.com/files/firefly/Using_Firefly_on_an_iPad.pdf)
Program Manufacturer Contact Info
Cambium Learning Technologies
Kurzweil Educational Systems
Phone Number: 800-894-5374; Outside of US and Canada: +1-508-315-6600
Website: Website for Kurzweil (https://www.kurzweiledu.com/products/k3000-mac.html) 
Cost of the product
Cost: $1395 at the time of this quick start publication date. 
(Students registered with the ATRC may be able to use Kurzweil on their home computers through our site license while they are students at CSU.)

Assistive Technology Resource Center		Jacob Sunder
Colorado State University		October 2015
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